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Introduction

ou made the right choice twice: Mac OS X Snow Leopard and this book.

Take a deep breath and get ready to have a rollicking good time. That’s right.
This is a computer book, but it’s going to be fun. What a concept! Whether
you’re brand spanking new to the Mac or a grizzled old Mac vet, | guaran-
tee that reading this book to discover the ins and outs of Mac OS X Snow
Leopard will make everything easier. Wiley, Inc. (the publisher of this book)
couldn’t say as much on the cover if it weren’t true!

About This Book

This book’s roots lie with my international bestseller Macintosh System 7.5
For Dummies, an award-winning book so good that now-deceased Mac cloner
Power Computing gave away a copy with every Mac clone it sold. Mac OS X
Snow Leopard For Dummies is the latest revision and has been, once again,
completely updated to include all the Mac OS X goodness found in Snow
Leopard. In other words, this edition combines all the old, familiar features of
previous editions — but is once again updated to reflect the latest and great-
est offering from Apple as well as feedback from readers.

Why write a For Dummies book about Snow Leopard? Well, Snow Leopard is a
big, somewhat complicated, personal-computer operating system. So [ made
Mac OS X Snow Leopard For Dummies a not-so-big, not-very-complicated book
that shows you what Snow Leopard is all about without boring you to tears,
confusing you, or poking you with sharp objects.

In fact, I think you’ll be so darned comfortable that [ wanted the title to be
Mac OS X Snow Leopard Without Discomfort, but the publishers wouldn’t let
me. Apparently, we For Dummies authors have to follow some rules, and using
Dummies and Mac OS X Snow Leopard in this book’s title are among them.

And speaking of “dummies,” remember that it’s just a word. I don’t think you're
dumb — quite the opposite! My second choice for this book’s title was Mac
OS X Snow Leopard For People Smart Enough to Know They Need Help with I,
but you can just imagine what Wiley thought of that. (“C’'mon, that’s the whole
point of the name!” they insisted. “Besides, it’s shorter our way.”)
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Anyway, the book is chock-full of information and advice, explaining every-
thing you need to know about Mac OS X in language you can understand —
along with timesaving tips, tricks, techniques, and step-by-step instructions,
all served up in generous quantities.

What Vou Won't Find in This Book

Another rule we For Dummies authors must follow is that our books cannot
exceed a certain number of pages. (Brevity is the soul of wit, and all that.)
So I wish I could have included some things, but they didn’t fit. Although I
feel confident you'll find everything you need to know about Mac OS X Snow
Leopard in this book, some things bear further looking into, including these:

v+ Information about some of the applications (programs) that come with
Mac OS X Snow Leopard: An installation of Mac OS X Snow Leopard
includes more than 50 separate applications, mostly found in the
Applications folder and the Utilities folder within it. I'd love to walk you
through each one of them, but that would have required a book a whole
lot bigger, heavier, and more expensive than this one.

This book is, first and foremost, about using Mac OS X, so I brief you on
the small handful of bundled applications essential to using Mac OS X
Snow Leopard and keep the focus there — namely, iCal, Address Book,
Mail, Safari, TextEdit, and the like, as well as important utilities you may
need to know how to use someday.

For what it’s worth, many books cover the applications that come with
Mac OS X Snow Leopard as well as applications commonly bundled with
Snow Leopard on a new Mac, such as iLife; the one my publisher sug-
gested | recommend is Mac OS X Snow Leopard All-in-One For Dummies,
written by Mark L. Chambers, which is (by sheer coincidence, of course)
also published by Wiley.

+~ Information about Microsoft Office, iLife, iWork, Adobe Photoshop,
Quicken, and most other third-party applications: Okay, if all the gory
details of all the bundled (read: free) Mac OS X Snow Leopard applica-
tions don’t fit here, I think you’ll understand why digging into third-party
applications that cost extra was out of the question.

v Information about programming for the Mac: This book is about using
Mac OS X Snow Leopard, not writing code for it. Dozens of books cover
programming on the Mac, most of which are two or three times the size
of this book.

For what it’s worth, Dennis Cohen, my technical editor, and his brother
Michael wrote a great book about Xcode 3, the development environment
included with Mac OS X Snow Leopard. It’s called The Xcode 3 Book and,
by sheer coincidence, is also published by (who else?) Wiley.
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Conventions Used in This Book

To get the most out of this book, you need to know how I do things and why.
Here are a few conventions I use in this book to make your life easier:

+* When | want you to open an item in a menu, [ write something like
“Choose File>Open,” which means, “Pull down the File menu and
choose the Open command.”

v Stuff you're supposed to type appears in bold type, like this.

1 Sometimes an entire a sentence is in boldface, as you see when I pres-
ent a numbered list of steps. In those cases, I leave the bold off what
you're supposed to type, like this.

v Web addresses, programming code (not much in this book), and things
that appear on-screen are shown in a special monofont typeface, 1ike
this.

v For keyboard shortcuts, [ write something like 88+A, which means to hold
down the 3 key (the one with the little pretzel and/or ® symbol on it) and
then press the A key on the keyboard. If you see something like 88 +Shift+A,
that means to hold down the 38 and Shift keys while pressing the A key.
Again, for absolute clarity, I never refer to the 38 key with the ® symbol. I
reserve that symbol for the ® menu (Apple menu). For the Command key,
[ use only the 38 symbol. Got it? Very cool.

Foolish Assumptions

Although [ know what happens when you make assumptions, I've made a few
anyway. First, [ assume that you, gentle reader, know nothing about using
Mac OS X — beyond knowing what a Mac is, that you want to use OS X, that
you want to understand OS X without having to digest an incomprehensible
technical manual, and that you made the right choice by selecting this
particular book.

And so I do my best to explain each new concept in full and loving detail.
Maybe that’s foolish, but . . . oh well.

Oh, and I also assume that you can read. If you can’t, ignore this paragraph.
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How This Book Is Organized

Mac OS X Snow Leopard For Dummies is divided into six logical parts, num-
bered (surprisingly enough) 1 through 6. By no fault of mine, they’re numbered
using those stuffy old Roman numerals, so you see I-VI where you (in my
humble opinion) ought to see Arabic numbers 1-6. It’s another rule that For
Dummies authors have to follow, I think.

Anyway, it’s better if you read the parts in order, but if you already know a lot —
or think you know a lot — feel free to skip around and read the parts that
interest you most.

Part I: Introducing Mac OS X Snow Leopard: The Basics: This first part is
very, very basic training. From the mouse to the Desktop, from menus, win-
dows, and icons to the snazzy-but-helpful Dock, it’s all here. A lot of what you
need to know to navigate the depths of Mac OS X safely (and sanely) and per-
form basic tasks can be found in this part. And although old-timers might just
want to skim through it, newcomers should probably read every word. Twice.

Part II: Snow Leopard Taming (Or “Organization for Smart People”): In
this part, I build on the basics of Part I and really get you revving with your
Mac. Here, I cover additional topics that every Mac user needs to know,
coupled with some hands-on, step-by-step instructions. The part starts with
a closer look at ways you can organize your files and folders, followed by a
chapter about using removable media (which means ejectable discs — mostly
CDs and DVDs). Last, but certainly not least, is a chapter about all the Snow
Leopard applications (such as iCal, Address Book, and Mail) that help you
keep your digital life organized.

Part III: Do Unto Snow Leopard: Getting Things Done: This part is chock-full
of ways to do productive stuff with your Mac. In this section, you discover
the Internet first — or at least how to get it working on your Mac and what to
do with it after you do. Next, you look at the digital-media side of things with
chapters about music, video, games, and digital photos. Finally, you look at
Snow Leopard’s built-in tools for writing — namely, TextEdit and fonts.

Part IV: Making This Snow Leopard Your Very Own: Here I get into the nitty-
gritty underbelly of making Mac OS X Snow Leopard work the way you want it
to work. I start with the ins and outs of printing under OS X. Then I move on
to somewhat more advanced topics, such as file sharing, creating and using
multiple user accounts (and why you might want to), and the lowdown on
numerous Mac OS X Snow Leopard features — Text to Speech, speech recog-
nition, automation, and more — that can make your computing experience
even more pleasant.
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Part V: The Care and Feeding of Your Snow Leopard: This part starts with
a chapter about backups and security, which not only stresses the impor-
tance of backing up your data, but also shows you how to do it almost pain-
lessly. Then I introduce you to a handful of useful utilities included with Snow
Leopard, and explain when and how to use them. Finally, I tell you how to
avoid most disasters, as well as what to do in the unlikely event that a major
mishap does occur.

Part VI: The Part of Tens: Finally, it’s The Part of Tens, which might have
started life as a Letterman rip-off, but does include heaping helpings of tips,
optional software, great Mac Web sites, and hardware ideas.

Appendix: Last, but certainly not least, I cover installing Mac OS X Snow
Leopard in the appendix. The whole process has become quite easy with this
version of the system software, but if you have to install Snow Leopard your-
self, it would behoove you to read this helpful appendix first.

Icons Used in This Book

A\\S

Little round pictures (icons) appear off to the left side of the text throughout
this book. Consider these icons miniature road signs, telling you a little some-
thing extra about the topic at hand. Here’s what the different icons look like
and what they all mean.

Look for Tip icons to find the juiciest morsels: shortcuts, tips, and undocu-
mented secrets about Snow Leopard. Try them all; impress your friends!

When you see this icon, it means that this particular morsel is something that
[ think you should memorize (or at least write on your shirt cuff).

Put on your propeller-beanie hat and pocket protector; these parts include the
truly geeky stuff. It’s certainly not required reading, but it must be interesting
or informative, or [ wouldn’t have wasted your time with it.

Read these notes very, very, very carefully. (Did I say very?) Warning icons flag
important cautionary information. The author and publisher won’t be respon-
sible if your Mac explodes or spews flaming parts because you ignored a
Warning icon. Just kidding. Macs don’t explode or spew (with the exception of
a few choice PowerBook 5300s, which won’t run Snow Leopard anyway). But I
got your attention, didn’t I? I'll tell you once again: It is a good idea to read the
Warning icons very carefully.
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These icons represent my ranting or raving about something that either bugs
me or makes me smile. When I'm ranting, imagine foam coming from my
mouth. Rants are required to be irreverent, irrelevant, or both. I try to keep
them short, more for your sake than mine.

Well, now, what could this icon possibly be about? Named by famous editorial
consultant Mr. Obvious, this icon highlights all things new and different in Mac
OS X Snow Leopard.

Where to Go from Here

\\j

Go to a comfortable spot (preferably not far from a Mac) and read the book.

The first few chapters of this book are where [ describe the basic everyday
things that you need to understand to operate your Mac effectively. If you're
new to Macs and OS X Snow Leopard, start there.

Even though Mac OS X Snow Leopard is way different from previous Mac
operating systems, the first part of the book is so basic that if you've been
using a Mac for long, you might think you know it all — and okay, you might
know most of it. But hey! Not-so-old-timers need a solid foundation. So here’s
my advice: Skip the stuff you know; you’ll get to the better stuff faster.

[ didn’t write this book for myself. [ wrote it for you — and would love to hear
how it worked for you. So please send me your thoughts, platitudes, likes and
dislikes, and any other comments. You can send snail-mail in care of Wiley, but
it takes a long time to reach me that way, and I just don’t have time to respond
to0 99.9% of it. If you want a response your best bet is to send e-mail to me
directly at SnowLeopard4Dummies@boblevitus.com. | appreciate your
feedback, and I try to respond to all reasonably polite e-mail within a few days.

Did this book work for you? What did you like? What didn’t you like? What
questions were unanswered? Did you want to know more about something?
Did you want to find out less about something? Tell me! | have received more
than 100 suggestions about previous editions, most of which are incorpo-
rated here. So keep up the good work!

So what are you waiting for? Go — enjoy the book!
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Introducing Mac 0S X
Snow Leopard:
The Basics

The 5th Wave By Rich Tennant
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" ,
“The odd thing is he always insists on using
the latest version of MAC 0S.”




In this part . . .

Because [ believe it’s important to crawl before you
walk, in this part you get a look at the most basic of
basics — such as how to turn on your Mac. Next, |
acquaint you with the Mac OS X Finder, with its Desktop,
windows, icons, and menus (oh my)! Then you find out
how to make this cat your own by customizing your work
environment to suit your style. After that is a date with
the Dock. And last but certainly not least, you discover
some additional tasks that will make life with Snow
Leopard ever so much easier.

So get comfortable, roll up your sleeves, fire up your Mac
if you like, and settle down with Part I, a delightful little
section I like to think of as “The Hassle-Free Way to Get
Started with Mac OS X Snow Leopard.”




Chapter 1

Mac 0S X Snow Leopard 101
(Prerequisites: None)

In This Chapter

Understanding what an operating system is and is not
Turning on your Mac

Getting to know the startup process

Turning off your Mac

Avoiding major Mac mistakes

Pointing, clicking, dragging, and other uses for your mouse

Getting help from your Mac

‘ ongratulate yourself on choosing Mac OS X, which stands for Macintosh
Operating System X — that’s the Roman numeral ten, not the letter X
(pronounced ten, not ex). You made a smart move because you scored more

than just an operating-system upgrade. Mac OS X Snow Leopard includes
several new features to make using your Mac easier, and dozens of improve-
ments that help you do more work in less time.

In this chapter, I start at the very beginning and talk about Mac OS X in
mostly abstract terms; then [ move on to explain what you need to know to
use Mac OS X Snow Leopard successfully.

If you've been using Mac OS X for a while, some of the information in this chapter
might seem hauntingly familiar; some features that I describe haven’t changed
from earlier versions of Mac OS X. But if you decide to skip this chapter because
you think you have all the new stuff figured out, I assure you that you’ll miss
at least a couple of things that Apple didn’t bother to tell you (as if you read
every word in Mac OS X Help, the only user manual Apple provides, anyway!).

Tantalized? Let’s rock.
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QNING/ If you’re about to upgrade to Snow Leopard from an earlier version of Mac OS X,
R [ feel obliged to mention a major pitfall to avoid: One very specific misplaced

click, done while installing your new OS, could erase every file on your hard
drive. The appendix describes this situation in full and loving detail, and it
contains other important information about installing Snow Leopard that can
make upgrading a more pleasant experience.

Gnawing to the Core of 0S X

The operating system (that is, the OS in Mac OS X) is what makes a Mac a
Mac. Without it, your Mac is a pile of silicon and circuits — no smarter than a
toaster.

“So what does an operating system do?” you ask. Good question. The short
answer is that an operating system controls the basic and most important
functions of your computer. In the case of Mac OS X and your Mac, the
operating system

1 Manages memory

v Controls how windows, icons, and menus work

v Keeps track of files

1 Manages networking

v Does housekeeping (No kidding!)
Other forms of software, such as word processors and Web browsers, rely on
the operating system to create and maintain the environment in which they
work their magic. When you create a memo, for example, the word processor
provides the tools for you to type and format the information. In the background,

the operating system is the muscle for the word processor, performing crucial
functions such as the following:

v Providing the mechanism for drawing and moving the on-screen window
in which you write the memo
v Keeping track of a file when you save it

v Helping the word processor create drop-down menus and dialogs for
you to interact with

v Communicating with other programs

v And much, much more (stuff that only geeks could care about)
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So, armed with a little background in operating systems, take a gander at the
next section before you do anything else with your Mac.

One last thing: As [ mention in the introduction (I'm only repeating it here in
case you normally don’t read introductions), Mac OS X Snow Leopard comes
with more than 50 applications. And though I'd love to tell you all about each
and every one, | have only so many pages at my disposal. If you need more
info on the programs [ don’t cover, may I (again) recommend Mac OS X Snow
Leopard All-in-One For Dummies, written by Mark L. Chambers; iLife All-in-
One For Dummies, written by my old friends Tony Bove and Cheryl Rhodes;
or iMovie & iDVD 09 For Dummies by the technical editor of this very book,

Dennis Cohen, and his brother Michael (all three titles are from Wiley).

The Mac advantage

Most of the world’s personal computers use
Microsoft Windows. But you’re among the
lucky few to have a computer with an operating
system that's intuitive, easy to use, and (dare
| say?) fun. If you don't believe me, try using
Windows for a day or two. Go ahead. You prob-
ably won’t suffer any permanent damage. In
fact, you'll really begin to appreciate how good
you have it. Feel free to hug your Mac. Or give
it a peck on the disc-drive slot — just try not to
get your tongue caught.

As someone once told me, “Claiming that the
Macintosh is inferior to Windows because
most people use Windows is like saying that
all other restaurants serve food that's inferior
to McDonald's.”

We might be a minority, but Mac users have
the best, most stable, most modern all-purpose
operating system in the world, and here’s why:
UNIX — on which Mac 0S X is based — is
widely regarded as the best industrial-strength
operating system on the planet. For now, just

know that being based on UNIX means that a
Mac running 0S X will crash less often than
an older Mac or a Windows machine, which
means less downtime. And being UNIX-based
also means far fewer viruses and malicious
software. But perhaps the biggest advantage
0S X has is that when an application crashes,
it doesn't crash your entire computer, and you
don’t have to restart the whole computer to
continue working.

By the way, with the advent of Intel-powered
Macs a few years ago, you can now run
Windows natively. That's right — you can now
install and run Microsoft Windows on any Mac
powered by an Intel processor, as described in
Chapter 16.

Don't let that UNIX stuff scare you. It's there
if you want it, but if you don't want it or don’t
care (like most of us), you'll rarely even know
it's there. All you'll know is that your Mac just
runs and runs and runs without crashing and
crashing and crashing.
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A Safety Net for the Absolute
Beginner (Or Any User)

In the following sections, I deal with the stuff that the manual that came with
your Mac doesn’t cover — or doesn’t cover in nearly enough detail. If you're a
first-time Macintosh user, please, please read this section of the book carefully —
it could save your life. Okay, okay, perhaps I'm being overly dramatic. What

I mean to say is that reading this section could save your Mac. Even if you're
an experienced Mac user, you might want to read this section anyway. Chances
are good that you’ll see at least a few things you might have forgotten that
might come in handy.

Turning the dang thing on

Okay. This is the big moment — turning on your Mac! Gaze at it longingly first
and say something cheesy, such as “You’re the most awesome computer I've
ever known.” If that doesn’t turn on your Mac (and it probably won'’t), keep
reading.

Apple, in its infinite wisdom, has manufactured Macs with power buttons on
every conceivable surface: on the front, side, and back of the computer itself,
and even on the keyboard or monitor.

So if you don’t know how to turn on your Mac, don’t feel bad — just look in
the manual or booklet that came with your Mac. It’s at least one thing that
the documentation always covers.

These days, most Macs have a power-on button near the keyboard (notebooks)
or the back side (iMacs). It usually looks like the little circle thingie you see in
the margin.

Don’t bother choosing Help=>Mac Help, which opens the Help Viewer program,
because it can’t tell you where the switch is. Although the Help program is
good for finding out a lot of things, the location of the power switch isn’t
among them. Of course, if you haven’t found the switch and turned on the Mac,
you can’t access Help anyway. (D’oh!)

What you should see on startup

When you finally do turn on your Macintosh, you set in motion a sophisticated
and complex series of events that culminates in the loading of Mac OS X and
the appearance of the Mac OS X Desktop. After a small bit of whirring,
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Figure 1-1:
This is what
you'll see if
everything

is fine

and dandy
when you
turn your
Mac on.
|
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buzzing, and flashing (meaning that the operating system is loading), OS X
first tests all your hardware — slots, ports, disks, random-access memory
(RAM), and so on. If everything passes, you hear a pleasing musical tone and
see the tasteful gray Apple logo in the middle of your screen, along with a
small spinning-pinwheel cursor somewhere on the screen. Both are shown in
Figure 1-1.

RUE
=
%

Here are the things that might happen when you power up your Mac:

v Everything is fine and dandy: Next, you might or might not see the
Mac OS X login screen, where you enter your name and password. If you
do, press Return or Enter (after you type your name and password, of
course), and away you go.

If you don’t want to have to type your name and password every time
you start or restart your Mac (or even if you do), check out Chapter 16
for the scoop on how to turn the login screen on or off.

Either way, the Desktop soon materializes before your eyes. If you
haven’t customized, configured, or tinkered with your Desktop, it should
look pretty much like Figure 1-2. Now is a good time to take a moment
for positive thoughts about the person who convinced you that you
wanted a Mac. That person was right!

v Blue/black/gray screen of death: If any of your hardware fails when it’s
tested, you might see a blue, black, or gray screen.

Some older Macs played the sound of a horrible car wreck instead of the
chimes, complete with crying tires and busting glass. It was exception-
ally unnerving, which might be why Apple doesn’t use it anymore.

The fact that something went wrong is no reflection on your prowess as
a Macintosh user. Something is broken, and your Mac may need repairs.
If this is happening to you right now, check out Chapter 19 to try to get
your Mac well again.
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Figure 1-2:
The Mac 0S
X Desktop
aftera
brand-
spanking-
new
installation
of 0S X.

O

If your computer is under warranty, dial 1-800-SOS-APPL, and a customer-
service person can tell you what to do. Before you do anything, though,
skip ahead to Chapter 19. It’s entirely possible that one of the sugges-
tions there can get you back on track without your having to spend even
a moment on hold.

v Prohibitory sign (formerly known as the flashing-question-mark disk):

Most users eventually encounter the prohibitory sign shown in the left
margin (which replaced the flashing question-mark-on-a-disk icon and
flashing folder icon back in Mac OS X Jaguar). This icon means your Mac
can’t find a startup disk, hard drive, network server, or DVD-ROM con-
taining a valid Macintosh operating system. See Chapter 19 for ways you
can try to ease your Mac’s ills.

v Kernel panic: You shouldn’t see this very often, but you might occasion-

ally see a block of text in four languages, including English, as shown in
Figure 1-3. This means that your Mac has experienced a kernel panic, the
most severe type of system crash. If you restart your Mac and see this
message again, look in Chapter 19 for a myriad of possible cures for all
kinds of ailments, including this one.



